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Abstract 
 

Vending Machines are automated machines that dispense selling products such as Cola, 

snacks, beverages, lottery tickets, and etc. It is vital to save time and reduce human energy. 

These vending machines are developed in the way of Non IoT based and IoT based 

methods. These Non IoT based machines are not smart and are not operated in real-time 

data, which are functioned when giving cash or card and inputs (vending things) of the 

machine. It is controlled by a micro-controller and distributed the given inputs. IoT- based 

machines are computerized, which have cashless payment facilities, order facility before 

going to the vending machine to order things, and can be identified the location of 

machines by the customer. These IoT-based machines are assisted to suppliers to identify 

the availability of the stocks. Simulation software and prototype are used to validate the 

machines. In this review, it is found that most of the vending machines developed are 

capable of operating without IoT technology, and nowadays, vending machine systems 

are required to implement using IoT with machine learning, and artificial technologies to 

satisfy the customer preferences. 
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Chapter 1 Introduction 

 

1.1 Background 

Nowadays, automated machines are in demand for making numerous activities not only easier, 

but also more efficient [1, 2]. These machines require minimal human intervention to carry out 

the work. The machine has numerous inputs and outputs to provide service to customers [3]. 

The Automatic machine operates based on electronics engineering, mechanical engineering, 

and electrical engineering, which is a collectivity termed Mechatronics [2]. People spend more 

time buying things in supermarkets as the market is crowded. Hence, it disappoints the 

customers and it leads to losing income to the vendors [4]. Normally people touch the things 

(mostly vegetables) to identify their quality. At that time, they can be affected by infectious 

diseases. Low hygiene and quality of most of the things are finally needed more workers to 

maintain the quality. Therefore, higher salary which needs to be paid to workers, and there is 

security issue as most of the customers use the cash payment method. As a result, design of the 

vending machine is the best solution to avoid these problems. The vending machine is one of 

these automated machines which supply needed things to the customer [4]. The vending 

machine can be categorized into product-oriented and service oriented machines [5]. It 

distributes snacks, beverages, public transit tickets, jewelry, telephone facility, entertainment 

things, and etc. [5]. 

 

As it has many benefits, such as, man power is no needed, flexibility in time, saving time [7], 

reducing labor cost, increasing profitability, and etc. [8]. Therefore, vending machines are used 

commonly worldwide [4]. Amid the COVID-19 crisis, vending machine usage is increased 

internationally [5]. US$134.4 Billion of the global market was estimated by using vending 

machines in 2020, and it is predicted as it will reach US$146.6 Billion in 2027. According to 

the report [9], 1.3 % of CAGR is analyzed in the period of 2020 to 2027. Currently, vending 

machine owners are facing challenges from hacking and vandalism [4]. Most customers want 

unmanned retail models and cashless payment methods because customer behavior has 

changed [2]. Lack of innovation and the way of the operating machine also affect the 

profitability of the machine [2]. Vending machines are faced with disruption of online delivery, 

which is increasing income by 23% in Japan [2]. Therefore, designing a touch-less, IoT-based, 

voice-recognized, and face-recognized vending machine is better solution to avoid these 
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problems. IoT applications are needed to monitor the environment, identify problems, 

communicate, and resolve problems without human intervention [10], and they have security 

issues in data sharing and privacy. Hence, security techniques are important to prevent 

confidential and important for device protection from some internet security threats [10]. In 

recent days, machine learning and artificial intelligence technologies are incorporated when 

developing vending machines. Therefore, it can be able to access real-time data collection, 

increase sales, make operation more efficient, and supply things to customer desire, which 

identifies the customer desire by which selected regular things are [11]. Comparison of current 

systems and identification of drawbacks are important in developing novel vending machine 

technologies as the usage of vending machine has been increase. Therefore, this article will 

focus on the comparison of systems developed under laboratory and factory conditions. In this 

article, a brief discussion on conventional methods used followed by existing IoT based 

vending technologies are also discussed. Then, statistical algorithms which were used in data 

analysis will be discussed 

 

1.2 Problem Statement  

This feasibility study aims to answer these following problems: 

 

Major Problem 

⚫ Is it feasible to put up vending machines in our country? 

 

Minor Problems 

⚫ What is the most preferred type of goods that consumers are willing to purchase? 

⚫ What is the consumer’s spending capacity? 

⚫ What are the most desired locations for vending machines? 

⚫ What is the rate of profitability? 

⚫ What are the benefits that the consumer can get out of this machine? 

⚫ How acceptable is the project, in terms of convenience and efficiency, for the 

consumers? 

 

 

 



3 

 

1.3 Objectives 

Goals that are intended to be achieved on this project is to develop a Cola Vending Machine 

with Arduino Pro Mini using Mobile Application. The main objective are the specific actions 

that need to be achieved on this research which deeply focus on aspect as below:  

 

⚫ To design and construct a Coin Operated Automatic Cola Vending Machine. 

⚫ To test the performance of a Coin Operated Automatic Cola Vending Machine. 

 

1.4 Motivation  

Similar to the development of traditional mobile phones into smartphones, vending machines 

have also progressively, though at a much slower pace, evolved into smart vending machines. 

Newer technologies at a lower cost of adoption, such as the large digital touch display, internet 

connectivity, cameras and various types of sensors, more cost-effective embedded 

computing power, digital signage, various advanced payment systems, and a wide range of 

identification technology (NFC, RFID, etc.) have contributed to this development. 

 

 

 

 

 

 

 

 

 

 

 

https://en.wikipedia.org/wiki/Mobile_phone
https://en.wikipedia.org/wiki/Smartphone
https://en.wikipedia.org/wiki/Touchscreen
https://en.wikipedia.org/wiki/Embedded_computing
https://en.wikipedia.org/wiki/Embedded_computing
https://en.wikipedia.org/wiki/Digital_signage
https://en.wikipedia.org/wiki/Near_field_communication
https://en.wikipedia.org/wiki/Radio-frequency_identification
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Chapter 2 Literature Review 

 

2.1 Introduction 

In this section topics related to Coin Operated Automatic Cola Vending Machine using Arduino 

are included. These provide a sampling of problems appropriate for application of a Coin 

Operated Automatic Cola Vending Machine using Arduino. The references are summarized 

below.  

2.2 Literature Survey 

In [1] A mobile robot vending machine for beaches based on consumers´ preferences and 

multivariate methods[2014] The paper illustrates how multivariate statistical techniques, 

namely factor and clusters analyses, can be used to examine the perceptions and preferences of 

customers and to support the development of a new energetically independent autonomous 

mobile robot vending machine for food distribution on beaches. Concerning the initial product 

assortment to be carried by the robot, nine food product items, many of them healthy, were 

identified; factor analysis identified that the respondents used seven main design dimensions 

when they assessed the robot, namely “Convenience”, “Menu”, “Automation”, “Distant 

Interaction”, “Aesthetics and Proximity”, “Sustainability” and “Sound Warning”. Cluster 

analysis applied to the respondents´ scores on the seven dimensions allowed five clusters of 

respondents to be found. Using cluster 3, the “green supporters”. 

 

As an example of a target segment, shows how this multivariate methodology can be used to 

guide the future development of the robot concept, with the suggestion that future work should 

focus on the enhanced use of renewable energies. In [2] Vending Machines in Australian 

Hospitals: Are They Meeting the Needs of the Consumer? [2021] This paper explores how well 

vending machines are meeting the needs of health care organizations and their staff and visitors 

in Australia. Hospital vending machines often provide the only source of food through the night 

to staff and visitors and traditionally offer less-healthy options. Findings presented in this report 

suggest that vending machines are not meeting current statewide policies and guidelines for 

healthier food environments in health care. This is despite widespread support for healthier 

refreshments in hospitals by staff, visitors, and patients. In [3] The association between sugar-

sweetened beverage availability in school vending machines and school staff sugar-sweetened 
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beverage consumption [2020] Reducing sugar-sweetened beverage (SSB) consumption is a 

leading strategy to help combat high rates of adult obesity and overweight. Regulating SSB 

sales in schools has reduced access among youth. However, current federal school nutrition 

standards are focused on the student rather than staff environments (i.e. school staff lounges). 

This study examines the association between the availability of SSBs in school vending 

machines and school staff SSB consumption. The study sample included 51 public schools in 

California, Oregon, Washington, Maryland, and Washington DC participating in an evaluation 

of Kaiser Permanente's Thriving Schools initiative in the school year 2017–18. Data collection 

included: 1) observations of school cafeterias, staff lounges, stores, and outdoor snack areas 

for the presence of, and content in, vending machines, and 2) an online survey of school staff 

about their SSB consumption. In [4] A systems engineering study of integration reverse 

vending machines into the waste management system of Kazakhstan [2021] This study aimed 

to understand the feasibility of the integration of RVMs into the waste management system of 

Kazakhstan. This would require gauging the opinions of all stakeholders that would be engaged 

in the potential integration process.  

 

The study aimed to identify the underlining reasons for the low recycling rate, the awareness, 

and willingness of the public to engage with RVMs, and also to obtain more insights on 

incentives that would motivate them the most. There are several limitations to the study. First, 

only Nursultan city's general public participated in the survey. It was limiting the findings to 

one locality. Second, RVMs in this study were studied only for plastic waste, which could be 

further extended to other types of waste. In [5] Snackomat - A Vending Machine To Create 

Positive Experiences By Bringing People In Contact And Initiating Small Talk In Waiting 

Situations [2020] In this paper, "Snackomat" is a vending machine offering snacks for free, 

installed in waiting situations, and is designed to initiate small talk and therewith create a 

positive experience. Here, we experimentally compare the effect on the user experience of the 

Snackomat to the effect of a coffee machine as a control condition with 58 participants. 

Participants' behavior was observed in waiting situations where observers were blind to the 

study's objective. The two experimental conditions were compared with an analysis of 

covariance. The alpha levels were Bonferroni corrected. Significant results with a strong effect 

size indicate that the Snackomat was more effective in creating positive experiences than a 

coffee machine in a control condition. In [6] Perceived acceptability of and willingness to use 

syringe vending machines: results of a cross-sectional survey of out-of-service people who 
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inject drugs in Tbilisi, Georgia[2019] In this paper perceived acceptability of syringe vending 

machines was extremely high among PWID not currently receiving any harm reduction or 

treatment services, with strong support indicated for uninterrupted free access to sterile 

injection equipment, privacy, and anonymity. Introducing SVM in Georgia holds the potential 

to deliver significant public health benefits by attracting hard-to-reach PWID, reducing unsafe 

injection behavior, and contributing to HIV testing uptake and linkage to care. 

 

2.3 Summary 

This literature helps us to build a brief concept of Coin Operated Automatic Cola Vending 

Machine using Arduino. Many people are trying to make this project. We also try this project. 

We are added four different sources which will be very helpful for user. 
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Chapter 3 Theory and Working Principle 

 

3.1 Methodology 

• Creating an idea for design and construction of a Coin Operated Automatic Cola 

Vending Machine. 

• Collecting the all components/materials for construct the system. 

• Finally, we made this system & checked it finally that working very well. 

 

3.2 Block Diagram: 

 

 

 

 

Figure 3.1: Block Diagram of a Coin Operated Automatic Cola Vending Machine. 
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3.3 Circuit Diagram 

 

 

 
 

Figure 3.2: Circuit Diagram of our Project 

 

3.4 Working Principle 

The main brain of our system is the Arduino Pro Mini. The way of whole project works is that 

we take 220V (rms) AC power from the supply voltage and then feed it to a Switch Mode Power 

Supply or in short SMPS module. The SMPS simply converts the 220V AC to a pure DC of 5V. 

We will use this 5V DC output from the SMPS to run our Arduino Pro Mini , Sensor and other 

units. We have used Arduino Pro Mini as the main controller of this system so that the system 

can be controlled via Wi-Fi. In this system we have used Coin operated for Cola Vending 

Machine. Here we use Arduino Pro Mini for main controller, IR sensor, Buck Converter, Relay, 

DC Gear motor, Motor Driver, Solenoid Valve, Display, and Keypad.   When the system is 

turned on,  the user can drop a coin through the slot provided and press the button of the required 

item. After the insertion and sense of the coin, the execution of the process starts. This is the 

main procedure of our system. 
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3.5 Project Prototype Image 

 

 
 

 

Figure 3.3: Project Prototype Image. 

 

3.6 Components List 

1. Arduino Pro Mini  

2. SMPS  

3. Buck Converter 

4. Relay 

5. DC Gear Motor 

6. Motor Driver 

7. IR Sensor 

8. Solenoid Valve 

9. LCD Display 

10. Keypad 
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Software:  

1. Arduino IDE 

2. Easy EDA 

        

3.6.1 Arduino Pro Mini 

The Arduino Pro Mini is a micro-controller board based on the ATmega168. It has 14 digital 

input/output pins (of which 6 can be used as PWM outputs), 6 analog inputs, an on-board 

resonator, a reset button, and holes for mounting pin headers. A six-pin header can be 

connected to an FTDI cable to provide USB power and communication to the board.  

Specifications 

⚫ Micro-controller ATmega168 

⚫ Operating Voltage: 3.3V or 5V (depending on model) 

⚫ Input Voltage: 3.35 -12 V (3.3V model) or 5 - 12 V (5V model) 

⚫ Digital I/O Pins: 14 (of which 6 provide PWM output) 

⚫ Analog Input Pins: 6 

⚫ DC Current per I/O Pin: 40 mA 

⚫ Flash Memory: 16 KB (of which 2 KB used by boot loader) 

⚫ SRAM: 1 KB 

⚫ EEPROM: 512 bytes 

⚫ Clock Speed: 8 MHz (3.3V model) or 16 MHz (5V model) 

 

 

Figure 3.4: Arduino Pro Mini 
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Pin Out 

Each of the 14 digital pins on the Pro Mini can be used as an input or output, using pin Mode(), 

digital Write(), and digital Read() functions. They operate at 3.3 or 5 volts (depending on the 

model). Each pin can provide or receive a maximum of 40 mA and has an internal pull-up 

resistor (disconnected by default) of 20-50 kOhms. In addition, some pins have specialized 

functions: 

• Serial: 0 (RX) and 1 (TX). Used to receive (RX) and transmit (TX) TTL serial data. 

These pins are connected to the TX-0 and RX-1 pins of the six pin header. 

• External Interrupts: 2 and 3. These pins can be configured to trigger an interrupt on a 

low value, a rising or falling edge, or a change in value. See the attach Interrupt() 

function for details. 

• PWM: 3, 5, 6, 9, 10, and 11. Provide 8-bit PWM output with the analog Write() 

function. 

• SPI: 10 (SS), 11 (MOSI), 12 (MISO), 13 (SCK). These pins support SPI 

communication, which, although provided by the underlying hardware, is not currently 

included in the Arduino language. 

• LED: 13. There is a built-in LED connected to digital pin 13. When the pin is HIGH 

value, the LED is on, when the pin is LOW, it's off. 

The Pro Mini has 6 analog inputs, each of which provide 10 bits of resolution (i.e. 

1024 different values). Four of them are on the headers on the edge of the board; two 

(inputs 4 and 5) on holes in the interior of the board. The analog inputs measure from 

ground to VCC. Additionally, some pins have specialized functionality: 

There is another pin on the board: 

• Reset. Bring this line LOW to reset the micro controller. Typically used to add a reset 

button to shields which block the one on the board. 

See also the mapping between Arduino pins and ATmega168 ports. 
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Figure 3.5: Arduino Pro Mini Pin Out 

 

The high-performance Microchip Pico Power 8-bit AVR RISC-based micro controller 

combines 32KB ISP flash memory with read-while-write capabilities, 1024B EEPROM, 2KB 

SRAM, 23 general purpose I/O lines, 32 general purpose working registers, three flexible 

timer/counters with compare modes, internal and external interrupts, serial programmable 

USART, a byte-oriented 2-wire serial interface, SPI serial port, a 6-channel 10-bit A/D 

converter (8-channels in TQFP and QFN/MLF packages), programmable watchdog timer with 

internal oscillator, and five software selectable power saving modes. The device operates 

between 1.8-5.5 volts. By executing powerful instructions in a single clock cycle, the device 

achieves throughputs approaching 1 MIPS per MHz, balancing power consumption and 

processing speed. 

Micro controller IC ATmega328p 

 

Figure 3.6: Micro controller IC AT Mega 328p 
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3.6.2 Switch Mode Power Supply (SMPS): 

A switched-mode power supply (switching-mode power supply, switch-mode power 

supply, switched power supply, SMPS, or switcher) is an electronic power supply that 

incorporates a switching regulator to convert electrical power efficiently. Like other power 

supplies, an SMPS transfers power from a DC or AC source (often mains power) to DC loads, 

such as a personal computer, while converting voltage and current characteristics. Unlike 

a linear power supply, the pass transistor of a switching-mode supply continually switches 

between low-dissipation, full-on and full-off states, and spends very little time in the high 

dissipation transitions, which minimizes wasted energy. A hypothetical ideal switched-mode 

power supply dissipates no power. Voltage regulation is achieved by varying the ratio of on-

to-off time (also known as duty cycles). In contrast, a linear power supply regulates the output 

voltage by continually dissipating power in the pass transistor. This higher power conversion 

efficiency is an important advantage of a switched-mode power supply. Switched-mode power 

supplies may also be substantially smaller and lighter than a linear supply due to the smaller 

transformer size and weight. 

 

0 

Figure 3.7: SMPS 

 

Switching regulators are used as replacements for linear regulators when higher efficiency, 

smaller size or lighter weight are required. They are, however, more complicated; their 

switching currents can cause electrical noise problems if not carefully suppressed, and simple 

designs may have a poor power factor. 

12V 5A Industrial SMPS Power Supply – 60W – DC Metal Power Supply – Good Quality – 

Non-Waterproof with Aluminum casing. 

https://en.wikipedia.org/wiki/Power_supply
https://en.wikipedia.org/wiki/Voltage_regulator#Switching_regulators
https://en.wikipedia.org/wiki/Electrical_power_conversion
https://en.wikipedia.org/wiki/Mains_electricity
https://en.wikipedia.org/wiki/Personal_computer
https://en.wikipedia.org/wiki/Voltage
https://en.wikipedia.org/wiki/Electric_current
https://en.wikipedia.org/wiki/Linear_power_supply
https://en.wikipedia.org/wiki/Dissipation
https://en.wikipedia.org/wiki/Voltage_regulator
https://en.wikipedia.org/wiki/Duty_cycle
https://en.wikipedia.org/wiki/Transistor
https://en.wikipedia.org/wiki/Power_factor
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• Input Voltage: AC 100 – 264V 50 / 60Hz 

• Output Voltage: 12V DC, 0-5A 

• Output voltage: Adjustment Range: ±20% 

• Protections: Overload / Over Voltage / Short Circuit 

• Auto-Recovery After Protection 

• Universal AC input / Full range 

• 100% Full Load Burn-in Test 

• Cooling by Free Air Convection 

• High Quality and High Performance 

• LED power supply with a metal body for hidden installation for LED lighting 

• Design with Built-in EMI Filter, improve signal precision. 

• Certifications: CE & RoHs 

• No Minimum Load. 

• Compact Size Light Weight. 

• High Efficiency, Reliability & low energy consumption 

• Category – Switch Mode Power Adaptor (SMPS) 

Switched-mode power supplies are classified according to the type of input and output voltages. 

The four major categories are: 

• AC to DC 

• DC to DC 

• DC to AC 

• AC to AC 

A basic isolated AC to DC switched-mode power supply consists of: 

• Input rectifier and filter 

• Inverter consisting of switching devices such as MOSFETs 

• Transformer 

• Output rectifier and filter 

• Feedback and control circuit 
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The input DC supply from a rectifier or battery is fed to the inverter where it is turned on and 

off at high frequencies of between 20 MHz and 200 MHz by the switching MOSFET or power 

transistors. The high-frequency voltage pulses from the inverter are fed to the transformer 

primary winding, and the secondary AC output is rectified and smoothed to produce the 

required DC voltages. A feedback circuit monitors the output voltage and instructs the control 

circuit to adjust the duty cycle to maintain the output at the desired level. 

 

Fig 3.8: SMPS Circuit Design  

 

Basic working concept of an SMPS 

A switching regulator does the regulation in the SMPS. A series switching element turns the 

current supply to a smoothing capacitor on and off. The voltage on the capacitor controls the 

time the series element is turned. The continuous switching of the capacitor maintains the 

voltage at the required level. 

Design basics 

AC power first passes through fuses and a line filter. Then it is rectified by a full-wave bridge 

rectifier. The rectified voltage is next applied to the power factor correction (PFC) pre-

regulator followed by the downstream DC-DC converter(s). Most computers and small 

appliances use the International Electro technical Commission (IEC) style input connector. As 

for output connectors and pin outs, except for some industries, such as PC and compact PCI, 

in general, they are not standardized and are left up to the manufacturer. 

There are different circuit configurations known as topologies, each having unique 

characteristics, advantages and modes of operation, which determines how the input power is 

https://www.electronicsforu.com/electronics-projects/power-factor-correction
https://www.iec.ch/about/?ref=menu
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transferred to the output. Most of the commonly used topologies such as fly-back, push-pull, 

half bridge and full bridge, consist of a transformer to provide isolation, voltage scaling, and 

multiple output voltages. The non-isolated configurations do not have a transformer and the 

power conversion is provided by the inductive energy transfer. 

 

Advantages of switched-mode power supplies: 

• Higher efficiency of 68% to 90% 

• Regulated and reliable outputs regardless of variations in input supply voltage 

• Small size and lighter 

• Flexible technology 

• High power density 

 

Disadvantages: 

• Generates electromagnetic interference 

• Complex circuit design 

• Expensive compared to linear supplies 

 

Switched-mode power supplies are used to power a wide variety of equipment such as 

computers, sensitive electronics, battery-operated devices and other equipment requiring high 

efficiency. 

Switch Mode Power Supply 

 

Fig 3.9: Power Supply Connection  



17 

 

Linear voltage IC regulators have been the basis of power supply designs for many years as 

they are very good at supplying a continuous fixed voltage output. Linear voltage regulators 

are generally much more efficient and easier to use than equivalent voltage regulator circuits 

made from discrete components such a zener diode and a resistor, or transistors and even op-

amps. The most popular linear and fixed output voltage regulator types are by far the 78… 

positive output voltage series, and the 79… negative output voltage series. These two types of 

complementary voltage regulators produce a precise and stable voltage output ranging from 

about 5 volts up to about 24 volts for use in many electronic circuits. There is a wide range of 

these three-terminal fixed voltage regulators available each with its own built-in voltage 

regulation and current limiting circuits. 

 

This allows us to create a whole host of different power supply rails and outputs, either single 

or dual supply, suitable for most electronic circuits and applications. There are even variable 

voltage linear regulators available as well providing an output voltage which is continually 

variable from just above zero to a few volts below its maximum voltage output. Most d.c. 

power supplies comprise of a large and heavy step-down mains transformer, diode rectification, 

either full-wave or half-wave, a filter circuit to remove any ripple content from the rectified 

d.c. producing a suitably smooth d.c. voltage, and some form of voltage regulator or stabilizer 

circuit, either linear or switching to ensure the correct regulation of the power supplies output 

voltage under varying load conditions. Then a typical d.c. power supply would look something 

like this: 

Typical DC Power Supply 

 

 

Fig 3.10: DC Power Supply Step 
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These typical power supply designs contain a large mains transformer (which also provides 

isolation between the input and output) and a dissipative series regulator circuit. The regulator 

circuit could consist of a single zener diode or a three-terminal linear series regulator to produce 

the required output voltage. The advantage of a linear regulator is that the power supply circuit 

only needs an input capacitor, output capacitor and some feedback resistors to set the output 

voltage. 

 

3.6.3 Buck Converter 

A buck converter (step-down converter) is a DC-to-DC power converter which steps down 

voltage (while drawing less average current) from its input (supply) to its output (load). It is a 

class of switched-mode power supply (SMPS) typically containing at least two semiconductors 

(a diode and a transistor, although modern buck converters frequently replace the diode with a 

second transistor used for synchronous rectification) and at least one energy storage element, 

a capacitor, inductor, or the two in combination. To reduce voltage ripple, filters made of 

capacitors (sometimes in combination with inductors) are normally added to such a converter's 

output (load-side filter) and input (supply-side filter). It is called a buck converter because the 

voltage across the inductor “bucks” or opposes the supply voltage.  

 

Figure 3.11: DC -DC Buck Converter 

DC-DC Buck Converter Step Down Module LM2596 Power Supply is a step-down(buck) 

switching regulator, capable of driving a 3-A load with excellent line and load regulation. These 

devices are available in fixed output voltages of 3.3 V, 5 V, 12 V, and an adjustable output 

version. The LM2596 series operates at a switching frequency of 150kHz, thus allowing 

smaller sized filter components than what would be required with lower frequency switching 

regulators. 

https://en.wikipedia.org/wiki/DC-to-DC_converter
https://en.wikipedia.org/wiki/Switched-mode_power_supply
https://en.wikipedia.org/wiki/Diode
https://en.wikipedia.org/wiki/Transistor
https://en.wikipedia.org/wiki/Synchronous_rectification
https://en.wikipedia.org/wiki/Capacitor
https://en.wikipedia.org/wiki/Inductor
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Specifications of DC-DC Buck Converter Step Down Module LM2596 Power Supply: 

• Conversion efficiency: 92% (highest) 

• Switching frequency: 150KHz 

• Output ripple: 30mA9maximum) 

• Load Regulation: ± 0.5% 

• Voltage Regulation: ± 0.5% 

• Dynamic Response speed: 5% 200uS 

• Input voltage:4.75-35V 

• Output voltage:1.25-26V(Adjustable) 

• Output current: Rated current is 2A, maximum 3A (Additional heat sink is required) 

• Conversion Efficiency: Up to 92% (output voltage higher, the higher the efficiency) 

• Switching Frequency: 150KHz 

• Rectifier: Non-Synchronous Rectification 

• Module Properties: Non-isolated step-down module (buck) 

• Short Circuit Protection: Current limiting, since the recovery 

Operating Temperature: Industrial grade (-40 to +85) (output power 10W or less) 

 

3.6.4 Motor driver 

The L293D is a popular 16-Pin Motor Driver IC. As the name suggests it is mainly used to 

drive motors. A single L293D IC is capable of running two DC motors at the same time; also 

the direction of these two motors can be controlled independently. 

 

 

Figure 3.12: Motor driver IC L293D 



20 

 

Working Process: 

L293D IC is a typical Motor Driver IC which allows the DC motor to drive on any direction. 

This IC consists of 16-pins which are used to control a set of two DC motors instantaneously 

in any direction. It means, by using a L293D IC we can control two DC motors. 

Features 

• Can be used to run Two DC motors with the same IC. 

• Speed and Direction control is possible 

• Motor voltage Vcc2 (Vs): 4.5V to 36V 

• Maximum Peak motor current: 1.2A 

• Maximum Continuous Motor Current: 600mA 

• Supply Voltage to Vcc1(vss): 4.5V to 7V 

• Transition time: 300ns (at 5Vand 24V) 

• Automatic Thermal shutdown is available 

L293D Pin Configuration 

Pin Number Pin Name Description 

1 Enable 1,2 
This pin enables the input pin Input 1(2) and Input 

2(7) 

2 Input 1 
Directly controls the Output 1 pin. Controlled by 

digital circuits 

3 Output 1 Connected to one end of  Motor 1 

4 Ground Ground pins are connected to ground of circuit (0V) 

5 Ground Ground pins are connected to ground of circuit (0V) 

6 Output 2 Connected to another end of  Motor 1 

7 Input 2 
Directly controls the Output 2 pin. Controlled by 

digital circuits 

8 Vcc2 (Vs) 
Connected to Voltage pin for running motors (4.5V 

to 36V) 
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9 Enable 3,4 
This pin enables the input pin Input 3(10) and Input 

4(15) 

10 Input 3 
Directly controls the Output 3 pin. Controlled by 

digital circuits 

11 Output 3 Connected to one end of Motor 2 

12 Ground Ground pins are connected to ground of circuit (0V) 

13 Ground Ground pins are connected to ground of circuit (0V) 

14 Output 4 Connected to another end of Motor 2 

15 Input 4 
Directly controls the Output 4 pin. Controlled by 

digital circuits 

16 Vcc2 (Vss) Connected to +5V to enable IC function 

 

Use of a L293D Motor Driver IC: 

Using this L293D motor driver IC is very simple. The IC works on the principle of Half H-

Bridge, let us not go too deep into what H-Bridge means, but for now just know that H bridge 

is a set up which is used to run motors both in clock wise and anti clockwise direction. As said 

earlier this IC is capable of running two motors at the any direction at the same time, the circuit 

to achieve the same is shown below. 

 

Figure 3.13: L293D circuit Diagram 
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All the Ground pins should be grounded. There are two power pins for this IC, one is the 

Vss(Vcc1) which provides the voltage for the IC to work, this must be connected to +5V. The 

other is Vs (Vcc2) which provides voltage for the motors to run, based on the specification of 

your motor you can connect this pin to anywhere between 4.5V to 36V, here I have connected 

to +12V. 

The Enable pins (Enable 1,2 and Enable 3,4) are used to Enable Input pins for Motor 1 and 

Motor 2 respectively. Since in most cases we will be using both the motors both the pins are 

held high by default by connecting to +5V supply. The input pins Input 1,2 are used to control 

the motor 1 and Input pins 3,4 are used to control the Motor 2. The input pins are connected to 

the any Digital circuit or micro controller to control the speed and direction of the motor. 

Applications 

• Used to drive high current Motors using Digital Circuits 

• Can be used to drive Stepper motors 

• High current LED’s can be driven 

• Relay Driver module (Latching Relay is possible) 

 

3.6.5 DC Gear Motor 

Electric motors turn electricity into motion by exploiting electromagnetic induction. A simple 

direct current (DC) motor is illustrated below. The motor features a permanent horseshoe 

magnet (called the stator because it's fixed in place) and an turning coil of wire called an 

armature (or rotor, because it rotates). 

 

 

Figure 3.14: DC Gear motor 
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Motor Specifications  

• Standard 130 Type DC motor 

• Operating Voltage: 4.5V to 9V 

• Recommended/Rated Voltage: 6V 

• Current at No load: 70mA (max) 

• No-load Speed: 9000 rpm 

• Loaded current: 250mA (approx.) 

• Rated Load: 10g*cm 

• Motor Size: 27.5mm x 20mm x 15mm 

Pin Description 

Table 01: DC Gear Motor Pin Out 

 

No: Pin Name Description 

1 Terminal 1 A normal DC motor would have only two terminals. Since these 

terminals are connected together only through a coil they have 

not polarity. Revering the connection will only reverse the 

direction of the motor 

2 Terminal 2 

  

Use of the DC motor:  

As the name suggests the Hobby DC motor is highly used by hobbyists who start exploring 

electronics. Hence this motor is very simple and easy to use. You can use any normal 9V battery 

or even a 5V supply since this motor has a operating range from 4.5V to 9V. In order to make 

it rotate just connect the positive (+) side of battery to one terminal and the Negative (-) sign 

of the battery to the other end and you should see the motor rotating. If you want to reverse the 

speed of the motor simply interchange the terminals and direction will also be reversed. In 

order to control the speed of the motor you have to vary the voltage supplied to the Motor the 

easiest way to do this is using a Potentiometer. There are also many other ways to achieve this. 

Also remember that the motor can consume up to 250mA during loaded conditions so make 
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sure you supply could source it. If you are controlling it through any Digital IC or any Micro-

controller you should use a motor driver IC like L293D or ULN2003  

Applications 

• Toy cars 

• Windmill projects 

• Basic Electronics projects 

• As Robot wheels 

 

3.6.6 LCD Display 

The LCD (liquid crystal display) screen is an electronic display module and looks for various 

applications. A 16x2 LCD display is a very basic module and it is very commonly used in 

various devices and circuits. These modules have been preferred over seven segments and 

many other segments because LCD is economical; Easily programmable, special and even 

custom characters (different in seven sections), there are no restrictions on displaying 

animations. A 16x2 LCD means it can display 16 characters per line and contains 2 lines. Each 

character on this LCD is displayed in a 5x7 pixel matrix. This LCD contains two articles called 

Command and Data. The command register stores the command instructions on the LCD. The 

command is a command given to the LCD to perform a predefined task such as starting it, 

clearing its screen, locating the cursor, controlling the display, etc. 

Features of LCD Display: 

Built-in controller (KS 0066 or Equivalent) + 5V power supply (Also available for + 3V) 1/16 

duty cycle B/L to be driven by pin 1, pin 2 or pin 15, pin 16 or A.K (LED) N.V. optional for + 

3V power supply. 

 

 

 

 

Figure 3.15.: 16*2 LCD Display 
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3.6.7 IR Sensor 

An infrared sensor is an electronics device that emits certain features around it and / or detects 

infrared radiation. Infrared sensors are capable of measuring the heat emitted by an object and 

detecting motion. In this project we will control the fan and light automatically through the 

closed loop system so the IR sensor for the system is definitely needed as a response. Here the 

fan will turn on and the light will turn on when the IR sensor detects an object and the fan and 

light will switch off automatically when an object leaves the house. 

 

 

 

 

 

 

 

Figure 3.16:   IR Sensor 

 

 

 

 

Figure 3.17:  IR sensor reflection System. 
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Principles of operation: 

Sensor works with sense. When an object intersects the sensor light then the sensor detects 

something. Some infrared ray is deflected from the object and scene the length of this distance. 

In this sensor we can make a fixed length light and detect our exact object. If some object 

comes in front of this sensor then the sensor detects it and sends a signal in LED. 

 

 

Figure 3.18:  IR sensor Detection System 

 

3.6.8 Relay 

A relay is an electrically operated switch. Many relays use an electromagnet to mechanically 

operate a switch, but other operating principles are also used, such as solid-state relays. Relays 

are used where it is necessary to control a circuit by a separate low-power signal, or where 

several circuits must be controlled by one signal. The first relays were used in long 

distance telegraph circuits as amplifiers: they repeated the signal coming in from one circuit 

and re-transmitted it on another circuit. Relays were used extensively in telephone exchanges 

and early computers to perform logical operations. 

 

https://en.wikipedia.org/wiki/Electric
https://en.wikipedia.org/wiki/Switch
https://en.wikipedia.org/wiki/Electromagnet
https://en.wikipedia.org/wiki/Solid-state_relay
https://en.wikipedia.org/wiki/Electrical_telegraph
http://education.rec.ri.cmu.edu/content/electronics/boe/ir_sensor/images/409px-IR_Sensor_Principles.png
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Figure 3.19: Relay 

A type of relay that can handle the high power required to directly control an electric motor or 

other loads is called a contactor. Solid-state relays control power circuits with no moving parts, 

instead using a semiconductor device to perform switching. Relays with calibrated operating 

characteristics and sometimes multiple operating coils are used to protect electrical circuits 

from overload or faults; in modern electric power systems these functions are performed by 

digital instruments still called "protective relays". 

 

Magnetic latching relays require one pulse of coil power to move their contacts in one 

direction, and another, redirected pulse to move them back. Repeated pulses from the same 

input have no effect. Magnetic latching relays are useful in applications where interrupted 

power should not be able to transition the contacts. Magnetic latching relays can have either 

single or dual coils. On a single coil device, the relay will operate in one direction when power 

is applied with one polarity, and will reset when the polarity is reversed. On a dual coil device, 

when polarized voltage is applied to the reset coil the contacts will transition. AC controlled 

magnetic latch relays have single coils that employ steering diodes to differentiate between 

operate and reset commands. The relay module is the one in the figure below. 

https://en.wikipedia.org/wiki/Contactor
https://en.wikipedia.org/wiki/Solid-state_relay
https://en.wikipedia.org/wiki/Moving_parts
https://en.wikipedia.org/wiki/Protective_relay
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Figure 3.20: Relay Module. 

This module has two channels (those blue cubes). There are other varieties with one, four and 

eight channels. 

Main’s voltage connections. 

In relation to mains voltage, relays have 3 possible connections: 

 

Figure 3.21: Main’s voltage connections. 

COM: common pin 

NO (Normally Open): there is no contact between the common pin and the normally 

open pin. So, when you trigger the relay, it connects to the COM pin and supply is 

provided to a load 
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NC (Normally Closed): there is contact between the common pin and the normally 

closed pin. There is always connection between the COM and NC pins, even when the 

relay is turned off. When you trigger the relay, the circuit is opened and there is no supply 

provided to a load. 

Pin wiring 

         The connections between the relay module and the Arduino are really simple: 

GND: goes to ground 

IN1: controls the first relay (it will be connected to an Arduino digital pin) 

IN2: controls the second relay (it should be connected to an Arduino digital pin if you  

are using this second relay. Otherwise, you don’t need to connect it) 

VCC: goes to 5V 

 

Figure 3.22: Voltage connections. 

 

3.6.9 Solenoid Valve 

They are widely used in the pneumatic industry. These valves make use of electro 

mechanical solenoids for sliding of the spool. Because simple application of electrical power 
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provides control, these valves are used extensively. However, electrical solenoids cannot 

generate large forces unless supplied with large amounts of electrical power. Heat generation 

poses a threat to extended use of these valves when energized over time. Many have a limited 

duty cycle. This makes their direct acting use commonly limited to low actuating forces. Often, 

a low power solenoid valve is used to operate a small pneumatic valve (called the pilot) that 

starts a flow of fluid that drives a larger pneumatic valve that requires more force. A bi-stable 

pneumatic valve is typically a pilot valve that is a 3 ported 2 position detent valves. The valve 

retains its position during loss of power, hence the bi-stable name. Bi-stability can be 

accomplished with a mechanical detent and 2 opposing solenoids or a "magna-latch" magnetic 

latch with a polarity sensitive coil. Positive opens and negative closes or vice versa. The coil 

is held in position magnetically when actuated. 

 

Type of spool 

Spool is of two types namely sliding and rotary. Sliding spool is cylindrical in cross section, 

and the lands and grooves are also cylindrical. Rotary valves have sphere-like lands and 

grooves in the form of holes drilled through them. 

 

Figure 3.23: Solenoid 5-way, 2 position Valve 

  

 

Specification: 

 

Model 4H210-08 

Type 5 port 2 postion hand lever valve 

Valve type 2 postion 

Material Aluminum 

Media Air 
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Operating Direct acting 

Orifice size 16mm²(Cv=1.67) 

Port size In= Out=PT1/4" 

Exhausl 1/8" 

Pressure range 1.5~8Kgf/cm² 

Temp Range -5~60℃ 

Lubrication Not required 

Operating angle +-15% 

Code 200 series 

Dimension 76.7 * 35 * 22mm 

 

Table 3.1.2: Specification Solenoid Valve  

 

When the reciprocating air compressor reaches the cut-out pressure setting the power supply to 

the compressor motor stops, and as a result, the compressor pump stops. The compressor pump 

stops, regardless of where the piston in the cylinder is located, and that often means that there 

is compressed air trapped over the piston when the pump stops on cut out. 

On other pages on this site we talk about how marginal a 120-volt air compressor motor really 

is, and the steps the motor manufacturers must take to ensure that, even with all compressor 

components working at their best, even being able to start. 

If air is trapped over the piston on the air compressor, that adds load to the start circuit. Your 

120-volt power supply hasn’t got enough oomph to start the motor without help from a start 

capacitor anyway, and that additional load on the compressor motor is typically sufficient to 

prevent the air compressor from starting. 
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Figure 3.24: Schematic Diagram of Solenoid Valve 

 

3.6.10 Keypad 

This 16-button keypad provides a useful human interface component for micro-controller 

projects. Convenient adhesive backing provides a simple way to mount the keypad in a variety 

of applications. 

This 16-button keypad provides a useful human interface component for micro-controller 

projects. It's made of a thin, flexible membrane material with an adhesive backing so you can 

attach it to nearly anything. The keys are connected into a matrix, so you only need 8 micro-

controller pins (4-columns and 4-rows) to scan through the pad. Check the tutorials tab for 

links to an Arduino library and example code. 

 
Figure 3.25: Keypad 

 

 

Features: 

Ultra-thin design 

Adhesive backing 
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Excellent price/performance ratio 

Easy interface to any micro controller 

 

Key Specifications: 

Maximum Rating: 24 VDC, 30 mA 

Interface: 8-pin access to 4x4 matrix 

Operating temperature: 32 to 122 °F (0 to 50°C) 

 

Dimensions: 

Keypad, 2.7 x 3.0 in (6.9 x 7.6 cm) 

Cable: 0.78 x 3.5 in (2.0 x 8.8 cm) 

 

Application Ideas: 

Security systems 

Menu selection 

Data entry for embedded systems 

 

3.6.11 Arduino IDE 

The digital micro-controller unit named as Arduino Nano can be programmed with the Arduino 

software IDE. There is no any requirement for installing other software rather than Arduino. 

Firstly, Select "Arduino Nano from the Tools, Board menu (according to the micro-controller 

on our board). The IC used named as ATmega328 on the Arduino Nano comes pre burned with 

a boot loader that allows us to upload new code to it without the use of an external hardware 

programmer. 

Communication is using the original STK500 protocol (reference, C header files). We can also 

bypass the boot loader and programs the micro-controller through the ICSP (In Circuit Serial 

Programming) header. The ATmega16U2 (or 8U2 in the rev1 and rev2 boards) firmware 

source code is available. The ATmega16U2/8U2 is loaded with a DFU boot loader, which can 

be activated by: 

On Rev1 boards: connecting the solder jumper on the back of the board (near the map of Italy) 

and then resetting the 8U2. On Rev2 or later boards: there is a resistor that pulling the 
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8U2/16U2 HWB line to ground, making it easier to put into DFU mode. 

The Arduino Nano is one of the latest digital micro-controller units and has a number of 

facilities for communicating with a computer, another Arduino, or other micro-controllers. The 

ATmega328 provides UART TTL at (5V) with serial communication, which is available on 

digital pins 0 -(RX) for receive the data and pin no.1 (TX) for transmit the data. An 

ATmega16U2 on the board channels this serial communication over USB and appears as a 

virtual com port to software on the computer. The '16U2 firmware uses the standard USB COM 

drivers, and no external driver is needed. However, on Windows, an .in file is required. The 

Arduino software includes a serial monitor which allows simple textual data to be sent to and 

from the Arduino board. 

The RX and TX LEDs on the board will flash when data is being transmitted via the USB-to-

serial chip and USB connection to the computer (but not for serial Communication on pins 0 

and 1). A Software Serial library allows for serial communication on any of the Nano's digital 

pins. The ATmega328 also supports I2C (TWI) and SPI communication. The Arduino software 

includes a Wire library to simplify use of the I2C bus. Arduino programs are written in C or 

C++ and the program code written for Arduino is called sketch. The Arduino IDE uses the 

GNU tool chain and AVR Lab to compile programs, and for uploading the programs it uses 

argued. As the Arduino platform uses Atmel micro-controllers, Atmel's development 

environment, AVR Studio or the newer Atmel Studio, may also be used to develop software 

for the Arduino. 

 

Figure 3.26: Arduino IDE Interface 



35 

 

Figure 3.28: Arduino Software Interface IDEThe Arduino Integrated Development 

Environment - or Arduino Software (IDE) - contains a text editor for writing code, a message 

area, a text console, a toolbar with buttons for common functions and a series of menus. It 

connects to the Arduino and Genuino hardware to upload programs and communicate with 

them. 

Writing Sketches 

Programs written using Arduino Software (IDE) are called sketches. These sketches are written 

in the text editor and are saved with the file extension .ino. The editor has features for 

cutting/pasting and for searching/replacing text. The message area gives feedback while saving 

and exporting and also displays errors. The console displays text output by the Arduino 

Software (IDE), including complete error messages and other information. The bottom 

righthand corner of the window displays the configured board and serial port. The toolbar 

buttons allow you to verify and upload programs, create, open, and save sketches, and open 

the serial monitor. 

Sketchbook The Arduino Software (IDE) uses the concept of a sketchbook: a standard place 

to store your programs (or sketches). The sketches in your sketchbook can be opened from the 

File > Sketchbook menu or from the Open button on the toolbar. The first time you run the 

Arduino software, it will automatically create a directory for your sketchbook. You can view 

or change the location of the sketchbook location from with the Preferences dialog. Beginning 

with version 1.0, files are saved with a .ino file extension. Previous versions use the .pde 

extension. You may still open .pde named files in version 1.0 and later, the software will 

automatically rename the extension to .ino. 

Tabs, Multiple Files, and Compilation 

Allows you to manage sketches with more than one file (each of which appears in its own tab). 

These can be normal Arduino code files (no visible extension), C files (.c extension), C++ files 

(.cpp), or header files (.h). 

Uploading 

Before uploading your sketch, you need to select the correct items from the Tools > Board and 

Tools > Port menus. The boards are described below. On the Mac, the serial port is probably 
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something like /dev/tty.usbmodem241 (for an Uno or Mega2560 or Leonardo) or 

/dev/tty.usbserial-1B1 (for a Duemilanove or earlier USB board), or 

/dev/tty.USA19QW1b1P1.1 (for a serial board connected with a Keyspan USB-to-Serial 

adapter). On Windows, it's probably COM1 or COM2 (for a serial board) or COM4, COM5, 

COM7, or higher (for a USB board) - to find out, you look for USB serial device in the ports 

section of the Windows Device Manager. On Linux, it should be /dev/ttyACMx , /dev/ttyUSBx 

or similar. Once you've selected the correct serial port and board, press the upload button in 

the toolbar or select the Upload item from the Sketch menu. Current Arduino boards will reset 

automatically and begin the upload. With older boards (pre-Diecimila) that lack auto-reset, 

you'll need to press the reset button on the board just before starting the upload. On most 

boards, you'll see the RX and TX LEDs blink as the sketch is uploaded. The Arduino Software 

(IDE) will display a message when the upload is complete, or show an error. 

 

When you upload a sketch, you're using the Arduino boot-loader, a small program that has 

been loaded on to the micro-controller on your board. It allows you to upload code without 

using any additional hardware. The boot-loader is active for a few seconds when the board 

resets; then it starts whichever sketch was most recently uploaded to the micro-controller. The 

boot-loader will blink the on-board (pin 13) LED when it starts (i.e. when the board resets). 

Libraries 

Libraries provide extra functionality for use in sketches, e.g. working with hardware or 

manipulating data. To use a library in a sketch, select it from the Sketch > Import Library 

menu. This will insert one or more #include statements at the top of the sketch and compile the 

library with your sketch. Because libraries are uploaded to the board with your sketch, they 

increase the amount of space it takes up. If a sketch no longer needs a library, simply delete its 

#include statements from the top of your code. There is a list of libraries in the reference. Some 

libraries are included with the Arduino software. Others can be downloaded from a variety of 

sources or through the Library Manager. Starting with version 1.0.5 of the IDE, you do can 

import a library from a zip file and use it in an open sketch. See these instructions for installing 

a third-party library. 
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Third-Party Hardware 

Support for third-party hardware can be added to the hardware directory of your sketchbook 

directory. Platforms installed there may include board definitions (which appear in the board 

menu), core libraries, boot loaders, and programmer definitions. To install, create the hardware 

directory, then unzip the third-party platform into its own sub-directory. (Don't use "Arduino" 

as the sub-directory name or you'll override the built-in Arduino platform.) To uninstall, simply 

delete its directory.For details on creating packages for third-party hardware, see the Arduino 

IDE 1.5 3rd party Hardware specification. 

 

Serial Monitor 

 

This displays serial sent from the Arduino or Genuino board over USB or serial connector. To 

send data to the board, enter text and click on the "send" button or press enter. Choose the baud 

rate from the drop-down menu that matches the rate passed to Serial.begin in your sketch. Note 

that on Windows, Mac or Linux the board will reset (it will rerun your sketch) when you 

connect with the serial monitor. Please note that the Serial Monitor does not process control 

characters; if your sketch needs a complete management of the serial communication with 

control characters, you can use an external terminal program and connect it to the COM port 

assigned to your Arduino board. 

 

3.6.12 Easy EDA Software 

Easy EDA is a web-based EDA tool suite that enables hardware engineers to design, simulate, 

share - publicly and privately - and discuss schematics, simulations and printed circuit boards. 

Other features include the creation of a bill of materials, Gerber files and pick and place files 

and documentary outputs in PDF, PNG and SVG formats. Easy EDA allows the creation and 

editing of schematic diagrams, SPICE simulation of mixed analogue and digital circuits and 

the creation and editing of printed circuit board layouts and, optionally, the manufacture of 

printed circuit boards. 

Subscription-free membership is offered for public plus a limited number of private projects. 

The number of private projects can be increased by contributing high quality public projects, 

schematic symbols, and PCB footprints and/or by paying a monthly subscription. Registered 

users can download Gerber files from the tool free of charge; but for a fee, Easy EDA offers a 

https://en.wikipedia.org/wiki/Electronic_design_automation
https://en.wikipedia.org/wiki/Circuit_diagram
https://en.wikipedia.org/wiki/Simulation
https://en.wikipedia.org/wiki/Printed_circuit_board
https://en.wikipedia.org/wiki/Bill_of_materials
https://en.wikipedia.org/wiki/Gerber_format
https://en.wikipedia.org/wiki/SPICE
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PCB fabrication service. This service is also able to accept Gerber file inputs from third party 

tools. 

 

Figure 3.27: Easy EDA Software Interface 
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Chapter 4 Results & Discussion 

 

4.1 Results 

We have been able to build our system by following all the objects and methodologies.  

 

Operation of the system 

⚫ At first we have set up the all components well for our system.  

⚫ Here the system is turned on, then the select the products of keypad. 

⚫ Then enter the coin of the coin tray and IR sensor sense the coin. 

⚫ Then the rotation mechanism of the DC Gear motor and the associated load ensure 

that proper operation takes place and the item is vented properly. 

⚫ Product show in LCD Display.  

 

Performance Test 

⚫ Project accuracy is 85%. 

⚫ It works 17 out of 20 times.  

⚫ After paying the coin it will take 20 seconds for the product to arrive. 

 

4.2 Advantages 

⚫ Happy and healthy employees. 

⚫ Convenience. 

⚫ Save time. 

⚫ Improves employee workplace satisfaction. 

⚫ Improves customer satisfaction. 

⚫ Increase in flexibility. 

 

4.3 Applications 

The project has a major application in the 

 

• It can be used for Shop. 

• It can be used in Shopping mall. 

• It can be used in Industrial Area. 
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4.4 Limitations 

It is a demo project so we found some limitation. In future we will work for reduce this kind 

of limitation. These limitations are – 

 

• It is a demo project so its accuracy is 85%. 

• Our project may delay in work. 

4.5 Discussion 

Vending machines fall into the non-store retailing section of retail. With vending machines 

there are numerous amounts of things that one could sell to the consumer. Non-store retailing 

is the selling of goods and services outside the confines of a retail facility. It is a generic term 

describing retailing taking place outside of shops and stores (i.e., off the premises of fixed retail 

locations and of market stands). The non-store distribution channel can be divided into direct 

selling (off-premises sales) and distance selling, the latter including all forms of electronic 

commerce. Distance selling includes mail order, catalogue sales, telephone solicitations, and 

automated vending. A vending machine can dispense a wide variety of merchandise when the 

consumer inserts money into it. 
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Chapter 5 Conclusion 

 

5.1 Conclusion: 

According to the systematic literature research, vending machines are mostly preferred by 

people to vend things. Therefore, more researchers have developed various types of vending 

machines according to the function of vending products or services and customer requirements 

which are categorized into IoT-based and Non-IOT based machines. Fewer machines are 

developed IOT-based worldwide. But vending machine usage is increasing worldwide in the 

Covid-19 situation. Hence, most companies are producing vending machine with new 

technologies. In this review, available vending machine technologies, limitations, and future 

expectations are discussed. Result of vending machine technologies, vending machines are 

developed using Micro-controller, Coin operated Automatic cola vending machine system to 

access machine, IR sensor, coin detector , thermal printer to print bill, keypad or touch pad to 

the input command, displays to show items, process instruction of the machine.  

. 

5.2 Future Scope 

The model can be improved by making some changes in the program and components. Some 

suggestions are given below- 

 

• We can add a monitoring-based control. 

• We will add some new sensor. 

• We will add an cc tv monitoring for Cola Vending Machine. 
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Appendix 

 

Micro-controller Code: 

#include <Keypad.h> 

#include<Wire.h> 

#include<LiquidCrystal_I2C.h> 

LiquidCrystal_I2C lcd(0x27, 16, 2); 

 

#define passwordsize 5 

 

char Masterpass[passwordsize] = "2043"; 

char Data[passwordsize]; 

byte data_count = 0; 

char customKey; 

 

int button = 11; 

int irsen = 10; 

int relay = 13; 

int count=0; 

int count1=0; 

int counter=0; 

int counter1=0; 

int ir; 

int butt; 

bool state; 

//motor A 

int in1=A0; 

int in2=A1; 

 

//motor B 

int in3=A2; 

int in4=A3; 

 

const byte ROWS = 4; //four rows 

const byte COLS = 4; //four columns 

//define the cymbols on the buttons of the keypads 

char hexaKeys[ROWS][COLS] = { 

  {'1','2','3','A'}, 

  {'4','5','6','B'}, 

  {'7','8','9','C'}, 

  {'*','0','#','D'} 

}; 

byte rowPins[ROWS] = {9, 8, 7, 6}; //connect to the row pinouts of the keypad c4,c3,c2,c1 

byte colPins[COLS] = {5, 4, 3, 2}; //connect to the column pinouts of the keypad r4,r3,r2,r1 

 

//initialize an instance of class NewKeypad 
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Keypad customKeypad = Keypad( makeKeymap(hexaKeys), rowPins, colPins, ROWS, 

COLS);  

 

 

 

void setup() { 

  Serial.begin(9600); 

  lcd.clear(); 

  lcd.init();      // initialize the lcd 

  lcd.backlight(); 

    

  pinMode(relay, OUTPUT); 

  pinMode(button, INPUT); 

  pinMode(irsen, INPUT); 

 

pinMode(in1,OUTPUT); 

pinMode(in2,OUTPUT); 

pinMode(in3,OUTPUT); 

pinMode(in4,OUTPUT); 

} 

 

void loop() { 

  

  ir = digitalRead(irsen); 

  butt= digitalRead(button); 

  Serial.println(butt); 

 

 if (butt == 0) { // check if push switch is pressed 

  lcd.setCursor(0,0); 

  lcd.print("Enter Password   "); 

   pass(); 

  } 

     

   if ( butt == 1) { 

      

    } 

 

if(ir==LOW){ 

   count1 = count++; 

   

//Serial.println(count1); 

    

  } 

if(ir==HIGH ){ 

 

   

  } 

   

if(count1>5 && count1<40){ 
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counter1=counter++; 

  Serial.print("counter1"); 

  Serial.println(counter1); 

} 

if(counter1>100){ 

 count=0; 

 count1=0; 

 counter=0; 

 counter1=0; 

 } 

 

if(counter1>5 &&counter1<101 ){ 

    cola(); 

  } 

 } 

 

 

void pass(){ 

   customKey = customKeypad.getKey(); 

  if(customKey) 

  { 

    lcd.setCursor(data_count,1); 

    lcd.print(customKey); 

    Data[data_count] = customKey;     

    data_count++;     

  } 

  if(data_count == passwordsize-1) 

  { 

    lcd.clear(); 

    if(!strcmp(Data,Masterpass)) 

    { 

      lcd.setCursor(0,0); 

      lcd.print("Password Matched"); 

      state = !state; 

      digitalWrite(relay, HIGH); 

        delay(5000); 

        digitalWrite(relay, LOW); 

    } 

    else 

    { 

      lcd.setCursor(0,0); 

      lcd.print("Wrong Password  "); 

    } 

    delay(1000); 

    data_count = 0; 

  }   

} 

 

void cola(){ 



47 

 

    lcd.setCursor(0, 0); 

    lcd.print("A=cola|| B=pepsi"); 

    customKey = customKeypad.getKey(); 

    Serial.println(customKey); 

   // delay(100); 

    if (customKey != NO_KEY) { 

      if (customKey == 'A') { 

        

        // Dispense a can from slot 1 

        lcd.clear(); 

        lcd.setCursor(0, 0); 

        lcd.print("Dispensing cola..."); 

 

       //motor L(f) 

        analogWrite(in4,0); 

       analogWrite(in2,150); 

       delay(4000); 

        analogWrite(in4,0); 

       analogWrite(in2,0); 

      } 

       if (customKey == 'B') { 

         

        // Dispense a can from slot 2 

        lcd.clear(); 

        lcd.setCursor(0, 0); 

        lcd.print("Dispensing pepsi..."); 

       //motor r(f) 

       analogWrite(in1,0);  

       analogWrite(in3,150); 

       delay(4000); 

       analogWrite(in1,0);  

       analogWrite(in3,0); 

        

       } 

      } 

      } 

 


